
 

Intro to Fusion 360  
Phil Eichmiller –  Autodesk, Lake Oswego, Oregon 
Michael Aubry – Autodesk, Lake Oswego, Oregon   

CD7017-L This hands-on lab will introduce the Fusion 360 3D CAD design app as a design tool for 

designers and engineers of all skill levels. We will focus on the basic functional areas of the Fusion 360 
app and lead the attendees through the modeling of a simple consumer product. We will cover T-Spline 
form creation, basic solid modeling and assembly, and materials and rendering. 

Learning Objectives 
At the end of this class, you will be able to: 

 Create and edit T-Spline forms 

 Perform basic solid modeling functions 

 Insert and assemble model components 

 Apply materials or appearances and render the model 

 

About the Speakers 

Phil Eichmiller is a product designer and Inventor user since 2000. Creating amazing product designs, 

packaging, marketing and tradeshow exhibits for Phoenix Gold International, Inc. He has been teaching 

Inventor at Portland Community College for 6 years to hundreds of degree seeking drafting students, 

connecting people to CAD with humor and manufacturing insight. Phil is a QA for Fusion 360 and has 

been very involved in the local community supporting and teaching Fusion 360 and other Autodesk 

products at FIRST Robotics events, PCC and the ADX maker space. phil.eichmiller@autodesk.com 

 



CD7017-L Intro to Fusion 360 

2 
 

Michael Aubry is a Technology Evangelist with the Autodesk Fusion 360 team. He’s always questing for 

better, faster and more exciting ways to digitally design. During the ten years he’s worked in the computer 

aided design field he’s had the privilege to work with 100s of customers ranging from boutique furniture 

designers to massive rock crushers. A mechanical engineer by education, Mike has worked in the bio-

medical, wind energy, and computational fluid dynamics simulation industries. He’s recently been part of 

a project to create an unmanned aerial vehicle to help save Rhinos in South Africa.  He’s very excited 

about all the recent advances in manufacturing to broaden the availability of prototyping to the everyman 

and Mike is very excited to help co-instruct this year’s Introduction to Fusion 360 seminar.  
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Overview 

Fusion 360 is a cloud-based CAD/CAM tool for collaborative product development. Let’s take a 

look at the separate parts of that sentence to get a better understanding of Fusion. 

 Cloud-based: Fusion 360 uses Autodesk A360 to manage all your design data. A360 gives you 
access to your data anywhere from any machine. With Fusion, we are concerned with 3D 
designs but A360 supports all your documents, spreadsheets, presentations and other design 
related files. 

 CAD/CAM: Fusion 360 contains all the tools you need to design and manufacture your products. 
There are CAD tools that let you create any shape to meet your design needs. Fusion 360 also 
supports additive and subtractive manufacturing workflows. Finally, you can create 2D 
documentation of your designs.  

 Collaborative: Use Fusion 360 with A360 to share designs and related information. You can also 
track activity on your projects. 

 

Design History 

Fusion 360 can work with or without recording design history. Design history refers to the 

operations you perform on the design to create and modify geometry. Operations are recoded in 

the timeline at the bottom of the interface.  

 

When using parametric modeling, the design history is captured in the timeline at the bottom of 

the interface. Operations are captured in the order they are performed in. History is captured for 

commands in the Model and Patch workspaces. You edit the operations in the timeline to make 

changes to your design. 

When using direct modeling, design history is not captured. The same commands are used from 

the toolbar but there is no timeline. You use commands like Press Pull or Move to move faces 

and change your design.  

So, why use one over the other? Use history when you need downstream operations to 

recalculate when you change other operations. For example, operations that go through-all or 

to-next recalculate with changes to upstream features. History is also useful if you plan to go 

between the model and sculpt workspaces. This allows you to create your shape, then create 

model operations (shell, split, hole, etc.) then go back and change your shape. If history is 

enabled, the model operations will recalculate to fit the new shape. 
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With direct modeling (history is off), you change geometry by moving faces. There are no 

operations to edit and therefore, no relationships between features in the design. Direct 

modeling works well for quick concept design or when working the imported data.  

You can control the default behavior for new designs using preferences or you can turn design 

history on/off in the browser after a model is created. 

 

 

Workspaces 

Fusion 360 uses workspaces control the commands that are available and the type of data that 

is created. There are multiple workspaces available depending on the work you plan to perform. 

 Sculpt: create organic shapes by manipulating faces, edges, and vertices. 

 Model: create solids with hard edges and flat faces. 

 Patch: create open surfaces to stitch into solid bodies. 

 Render: set up the environment and create photo-realistic renderings. 

 CAM: create and simulate tool-paths then generate g code for subtractive manufacturing. 

 Drawing: generate 2D manufacturing drawings. 

You also have a drawing workspace for documentation; render workspace for creating photo-

realistic renders, CAM workspace for creating tool paths. 

It’s obvious when to use some workspaces. If you need a 2D manufacturing drawing, you use 

the drawing workspace. What about model and sculpt? They are both used to create 3D 

designs so how do you choose to use one over the other? 

Use model to create designs with hard edges and flat faces. Model creates bodies requiring 

exact sizes and edges. Entering exact values is not required but is typical.  
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Use the sculpt workspace to create bodies with organic shapes. Sculpt bodies are highly curved 

and the shape is more critical than exact size.  

 

Very frequently, your designs will require that you work in both sculpt and model workspaces, 

back and forth. You might even throw patch in there to stitch surfaces together into a solid. You 
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can work entirely in sculpt, entirely in model, or you can combine the two. You can combine 

sculpt and model to create the shape required as well as precise manufacturing features. 

Create the organic shape in sculpt then use model for manufacturing features afterwards. 
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Main User Interface 

 

1. Application bar: 

  Data Panel: Display or hide the data panel on the left of the interface. 

  File: Access file operations such as New Design, Save, Export, and 3D Print. 

  Save: Save an untitled design or save the changes to a design as a new version. 

  Undo/redo: Undo or redo operations. 

2. Toolbar: Access commands in the toolbar. 

3. Profile and help: 

 Profile name: Access preferences and your Autodesk profile. 
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  Help: Access help, forums, and tutorials, what’s new, and feedback. 

4. ViewCube: Orbit the view and access orthographic and isometric views. 

5. Browser: Lists objects in the design.  

6. Marking menu: Another method to access commands. Right-click to display the marking menu. 

7. Timeline: List the operations performed on a design if parametric modeling is active. 

8. Navigation bar and display settings: The navigation bar contains commands to navigate the 

view. The display settings control the display of the design in the canvas. 

 

Data Panel Interface 

 

1. Project switcher: Select the active project. 

2. Project tools 

  Project Members: Invite members to the active project.  

  Project details: Opens the active project in Autodesk A360 in your default internet 

browser. 

  Search: Search the active project or all projects you have access to. 

3. Data tools 
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  Upload: Upload files to Autodesk A360. Many CAD data types are supported as well 

as standard files such as documents, spreadsheets, and presentations.  

  Data view: Select how data is displayed in the data panel. 

  Refresh: Refreshes data from Autodesk A360. 

4. Thumbnails: Right-click a thumbnail to access commands for that specific design. 

 

View Navigation 

Commands 

Use ViewCube to orbit the design in the canvas. Drag the ViewCube to perform a free orbit. 

Click faces and corners of the ViewCube to access standard orthographic and isometric views. 

 

Use the commands in the Navigation bar to pan, zoom, and orbit the canvas. The menus on the 

right end control Display Settings and Layout Grid options. 

 

Mouse 

 

Scroll the middle mouse wheel to zoom in or zoom out. 
SCROLL  
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Click and hold the middle mouse button to pan the view. 

 

Hold the SHIFT key and click and hold middle mouse button to 

orbit the view. 

 

Mac Trackpad 

 

2 finger pinch to zoom out. 

 

2 finger spread to zoom in 

 

2 finger swipe to pan the view. 

SHIFT 

KEY + 

HOLD    
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Hold SHIFT and 2 finger swipe to orbit the view. 

 

Hot Keys 

Command Windows Mac 

Undo Ctrl + Z Command + Z 

Redo Ctrl + Y Command + Y 

Copy Ctrl + C Command + C 

Paste Ctrl + V Command + V 

Cut Ctrl + X Command + X 

 

Sculpt Workspace Selection Windows Mac 

Grow selection Shift + Up arrow Shift + Up arrow 

Shrink selection Shift + Down arrow Shift + Down arrow 

Loop selection Alt + P Control + P 

Loop grow selection Alt + O Control + O 

Ring selection Alt + L Control + L 

Ring grow selection Alt + K Control + K 

Ring shrink selection Alt + J Control + J 

Previous U Alt + Left arrow Control + Command + Left arrow 

Next U Alt + Right arrow Control + Command + Right arrow 

SHIFT + 
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Previous V Alt + Down arrow Control + Command + Down arrow 

Next V Alt + Up arrow Control + Command + Up arrow 

Range selection Alt + M Command + M 

Invert selection Alt + N Command + N 

Toggle box mode Ctrl + 1 Ctrl + 1 

Toggle control frame mode Ctrl + 2 Ctrl + 2 

Toggle smooth mode Ctrl + 3 Ctrl + 3 

Select edge ring Double-click an edge Double-click an edge 

Select face ring Select two faces then 

double-click a third face 

Select two faces then double-click a 

third face 

 

Edit Form Command Windows Mac 

Add geometry Alt + Drag Option + Drag 

Add geometry and keep creases Alt + Ctrl + Drag Option + Command + Drag 
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Create and edit T-Spline Forms 
 

In this section you will learn how to: 

 Create a T-Spline form 

 Modify a T-Spline form 

 Add details to a T-Spline form 

 Create a T-Spline form based on a reference image 

 
Create a T-Spline Form from a Reference Image 

 

In this section you’ll learn how to create a T-Spline form based on a calibrated reference image. 

With the freeform capabilities that come along with sculpting Fusion 360, this is a very common 

workflow. Let’s get started by creating with a blank slate by creating a New Design.  

Design Setup – Attach Canvas: The first step is to learn how to attach a reference image to a 

particular plane and calibrate it to ensure an accurate design.  

Step 1 – Attach a canvas 

1. Click the drop-down arrow under the 
Insert menu. 

2. Click Attached Canvas. 
3. Select the YZ Plane (between the green 

and blue axes) to set the Canvas’ 
orientation. 

4. In the dialog window, click the Select 
Image button and navigate to the 
01_UtilityKnife.jpg file in the class data 
folder. 

 

  

Launch Video  

https://www.youtube.com/watch?v=mVGM7JPi5Ps&index=7&list=PLmA_xUT-8UlJpYbha60oAQMxFlBY371oZ
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Step 2 – Setup the canvas 

1. If necessary, rotate the canvas 90 degrees 
to orient it properly 

2. Lower the opacity to 85. 
3. Check the box for Display Through to 

ensure that the canvas can be seen 
through your T-Spline form. 

4. Click OK.  

 

 

Launch Video  

 

Step 3 – Start the calibrate tool 

1. We need to calibrate our canvas to make 
sure our utility knife fits in our palm, and 
not on our fingertip! 

2. In the Browser, click the drop-down arrow 
next to the Canvases folder. 

3. Right-Click on Utility Knife and select 
Calibrate. 

 

 

Launch Video  

 

Step 4 – Calibrate the canvas 

1. Click Right on the View Cube to view the 
utility knife from the side. 

2. Click once at the front of the utility knife. 
3. Click once at the back of the utility knife. 
4. Enter the approximate length, 180 mm. 
5. The canvas will scale up accordingly. 

 

 

 

 

http://youtu.be/mVGM7JPi5Ps?t=35s
http://youtu.be/mVGM7JPi5Ps?t=1m10s
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Create Primitive Form: With the canvas in place, the next step is to create a T-Spline primitive 

form on the proper plane.  

Step 1 – Start the Box Primitive 

1. Click the Create Form icon to enter the 
Sculpt workspace. 

2. Under the Create menu, select a primitive 
Box. 

3. Select the same side plane (YZ) as the 
canvas to specify the plane that the Box is 
placed on. 

4. Click once at the origin to specify the Box’s 
center point 

5. Move the mouse and click again to draw 
its 2D profile. 

 

 

Launch Video  

 

Step 2 – Specify the Box Primitive 

1. Set the Box’s Length, Width, and Height 
equal to 175, 35, and 25 mm, respectively. 

2. Set the number of Length Face equal to 5, 
and the width and height faces equal to 2. 

 

Looking at the form of the utility knife, the 

complexity is along the length of the knife, so we 

set additional faces in that direction. We can 

always add or remove these later on. 

 

  

Launch Video  

 

Step 3 – Add Symmetry 

1. In the dialog window, change the 
Symmetry from None to Mirror. 

2. Check the box for Height Symmetry. 
3. You’ll now see a green line that indicates 

where we have symmetry set up.  
4. With no more symmetry to add to our 

form, click OK. 

 

  

Launch Video  

 

http://youtu.be/mVGM7JPi5Ps?t=1m34s
http://youtu.be/mVGM7JPi5Ps?t=1m48s
http://youtu.be/mVGM7JPi5Ps?t=2m16s
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Edit the T-Spline Form: Our T-Spline primitive is now in place, but we need to edit its geometry 

to better match our reference picture. In the following steps, we’ll edit our existing geometry to 

match the canvas as best as we can. After that, we can add and subtract more edges to fine-

tune our design. 

Step 1 – Start the Edit Form tool 

1. Under the Modify menu, select Edit Form. 
2. For simplicity, ensure you’re looking at the 

form from the Right view.  
3. Again, to set this, you can click Right on 

the view cube. 
 

Common to most workflows, we’ll stick to 

modifying our form from just one view, proceeding 

to 3D manipulations as a final step. 

 

 

Launch Video  

 

Step 2 – Select a Loop of Faces 

1. Select the middle loop of faces going down 
the length of the utility knife with a 
window selection (left-click and hold), as 
shown in the picture. 

2. Dragging left to right will select all the 
geometry that is fully captured by the 
window, while right to left will capture 
everything that touches the window.  
 

 

 

 

Launch Video  

 

http://youtu.be/mVGM7JPi5Ps?t=2m31s
http://youtu.be/mVGM7JPi5Ps?t=2m44s
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Step 3 – Start Modifying the Form 

1. Using the Planar Translation manipulator, 
move the selected faces to align the top of 
the T-spline body with the top of the utility 
knife.  

2. To align the bottom in this section, select 
the bottom face and use the planar 
translation and rotate manipulators. 

3. Repeat the previous 2 steps for the rest of 
the T-spline form. It will also be helpful to 
use the single-direction scale manipulator 
in some cases. 

4. For more controlled editing, try modifying 
individual edges.  

5. Don’t worry if the finer details of the 
contour are not matched, as we will 
accomplish this in the next step by adding 
and subtracting edges. Shoot for the image 
on the right! 

 

 

 

 

Launch Video  

 

Add Additional Details – Insert Edge: Our T-Spline form is starting to resemble our reference 

image, but there are without a doubt some details that we’d like to add! As the form is right now, 

there simply aren’t enough edges available to capture all of the details that we’d like. To combat 

this, you’ll implement the earlier-discussed method of inserting and deleting edges into a T-

Spline form. 

Step 1 – Insert Additional Edges 

1. Holding shift, select the edges shown. 
2. Click the Modify drop-down arrow and 

select Insert Edge. 
3. Drag the direct manipulator to the right to 

position the new edges at an Insert 
Location around -0.5. 

4. Click OK. 
We’ll now repeat the previous steps to insert 

another set of edges. 

  

Launch Video  

 

http://youtu.be/mVGM7JPi5Ps?t=2m51s
http://youtu.be/mVGM7JPi5Ps?t=3m57s
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Step 2 – Insert more edges 

1. Holding shift, select the edges shown. 
2. Click the drop-down arrow under the 

Modify section and select Insert Edge. 
3. Drag the direct manipulator to the right to 

position the new edges at an Insert 
Location around -0.5. 

4. Click OK. 
The form will change due to the additional edges. 

In the next step we will edit our form to our liking. 

 

Launch Video  

 

Step 3 – Edit Form 

1. Using the Edit Form tool directly 
manipulate the recently inserted edges (as 
well as the surrounding geometry) to 
achieve the result shown on the right. 

2. The planar translation manipulator will be 
extremely useful.  

As you can see, the reference image will help us 

roughly capture the correct form, but the fine 

details are entirely up to us.  

 

 

 

Launch Video  

 

 

Add Additional Details – Insert Point: To insert the final two edges we need, we’ll actually 

learn a new tool, the Insert Point tool. Slightly different from Insert Edge, the Insert Point tool will 

easily insert an edge by connecting two midpoints together.  

Step 1 – Start the Insert Point command 

1. Click the Modify drop-down menu and 
select Insert Point. 

2. Hover over the middle of the top edge 
shown until a red circle appears. – this 
signifies the midpoint 

3. Click, and repeat for the edge directly 
beneath, located along the line of 
symmetry. 

 Launch Video  

http://youtu.be/mVGM7JPi5Ps?t=4m21s
http://youtu.be/mVGM7JPi5Ps?t=4m37s
http://youtu.be/mVGM7JPi5Ps?t=5m18s
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Step 2 – Insert Point details 

1. Leave the Insert Mode set to Simple. 
2. Click OK. 

 

Note: An Insert Mode of Simple will add the 

desired edge, but the form will change slightly. An 

Insert Mode of Exact will add the desired edge, as 

well as additional edges to maintain the previous 

form. As you can tell, this setting will be a trade-off 

between maintaining form and reducing the 

number of edges.  

 

 

 

Step 3 – Repeat Insert Point 

1. Click the Modify drop-down menu and 
select Insert Point. 

2. Construct an additional edge as shown to 
the right. 

3. Leave the Insert Mode set to Simple. 
4. Click OK. 

 

 

Launch Video  

Step 4 – Edit Form 

1. Using the Edit Form tool directly 
manipulate the recently inserted edges (as 
well as the surrounding geometry) to 
achieve the result shown on the right. 

2. Click Finish Form. 
 

Congratulations! You’ve completed your first 

sculpting workflow in Fusion 360. Feel free to 

sculpt the utility knife’s sides for even more detail. 

With a more complex form, a similar workflow can 

be utilized, but with multiple calibrated canvases. 

 

 

Launch Video  

 

 

 

http://youtu.be/mVGM7JPi5Ps?t=5m42s
http://youtu.be/mVGM7JPi5Ps?t=5m50s
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Perform basic solid modeling functions 

 

In this part of the modeling module, we’re going to work on the sculpted utility knife handle. 

We’re going to look at how to create mechanical features based on a sculpted body.  We’ll be 

using tools that we used in the previous lesson, as well as learn some new ones.   

Before moving on, make sure you have the 02_model_from_sculpted_body design open and 

in your design environment.  

If you like to watch the video to this tutorial, click here: Launch Video  

http://youtu.be/fpAJuAm5OGQ?list=PLmA_xUT-8UlJpYbha60oAQMxFlBY371oZ
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Step 1 

Let’s start by first shelling the body.  

1. Go to the MODIFY drop-down 

menu and select the Shell 

command.  

 

 

Step 2 

1. Go to the browser and locate the 

knife body.  

2. Click it once to select it as the 

body to shell.  

 

 

Step 3 

1. Instead of using the arrow 

manipulator, go to the floating 

command dialog and change the 

value to 2 mm. Hit ENTER to finish.  

 

Now that the body is shelled, we’re 

going to begin creating features on 

the inside.   
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Step 4 

1. To see the inside, go to the 

INSPECT drop-down and select 

Section Analysis. 

 

Note: Section Analysis lets you see 

a section of the model based on a 

reference plane or surface.  
 

Step 5 

1. Go to the browser and turn on 

the Origin planes.  

2. Select the plane that is in the 

middle of the knife body, parallel to 

the length of the model. Click OK to 

confirm.  

 

You should see half of the shelled 

model.  

 

Step 6 

We’re now going to set up some 

web features.  

1. Go to the RIGHT view on the 

ViewCube. 

2. Go to the SKETCH drop-down 

menu and select the Line 

command.  
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Step 7 

1. Choose the plane that is parallel 

to the section view.  

 

Step 8 

1. Go to the browser and turn on 

Sketches. You should see some 

profile sketches that have been 

already created.  

 

We’re going to use them as 

references for our line sketch.  

 

Step 9 

1. Hover over to the top of the 

blade profile until your cursor snaps 

to a grid intersection. Make sure 

that it is outside the knife body.  

 

If you’re having trouble snapping to 

the grid intersection, zoom in and 

the grid will scale accordingly.  
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Step 10 

1. Click once to place the start of 

your line sketch. Stretch the line 

across the knife body until it is on 

the other side.  

2. Click again to place the end point 

of the line.  

3. Press ESC key to end the 

command.  

 

Step 11 

1. Right click and select Repeat Line 

to reuse the Line command.  

 

Step 12 

1. Now repeat the same task at the 

bottom of the blade sketch profile. 

Snap to a grid intersection; click to 

place the starting point of the line.  
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Step 13 

1. Extend the line across the knife 

body until it reaches past the last 

circle sketch profile. Snap to a grid 

intersection; click to place the end 

point of the line.  

2. Press ESC to end the command.  

 

Step 14 

1. Right click and select Repeat Line 

to reuse the Line command. 

 

Step 15 

1. Draw a line that is perpendicular 

to the first and second line, making 

sure that it also extends past the 

knife body.  

2. When you’re done placing the 

end point of the 3rd line sketch, 

press STOP SKETCH to end 

sketching.   
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Step 16 

We’re now ready to model the 

webs. 

1. Go to the CREATE drop-down 

menu and select the Web 

command.  

 

Step 17 

1. Click on the 3 line sketches you 

just made so that they are selected 

as the references lines for your 

web.  

 

Step 18 

1. Change the thickness value to 2 

mm and hit ENTER to finish.  
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Step 19 

Now that you’ve created webs for 

one side, you’ll need to duplicate 

the task on the other. We’re going 

to do this by editing the Section 

Analysis.  

1. Go to the browser and expand 

the Analysis folder.  

 

Step 20 

1. Right click on the analysis and 

select Edit. 

 

Step 21  

1. In the command dialog to the 

right, click the red X to de-select 

previously selected plane.  
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Step 22 

1. Rotate the model around to the 

Left side, and then select the left 

side of the middle plane.  

 

Step 23 

1. You should be seeing the other 

half without the webs. Click OK to 

finish.  

 

Note: If you are having trouble 

selecting the plane, then click 

 

Step 24 

1. Go to the browser and turn on 

the sketch for the web.  
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Step 25 

1. Repeat the Web command.  

2. Select the 3 line sketches. 

3. Before setting a thickness, click 

Flip Direction in the command 

dialog so that the webs will be 

going in the right direction.  

  

Step 26 

1. Set the thickness to 2 mm. 

Click OK to finish.  

 

You now have webs on both sides  

of the model.  

 

Step 27 

We’re now going to create a boss 

hole right in the middle of where 

the webs intersect.  

 

1. Go to SKETCH drop-down menu, 

then Circle, and select Center 

Diameter Circle.  
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Step 28 

1. Click on the plane where the web 

line sketches were drawn, then 

hover to the intersection until the 

cursor snaps to the center. Place 

your circle there.   

 

Step 29 

1. Enter a value of 8 mm as the 

diameter. Press ENTER to confirm. 

2. Click Stop Sketch to exit the 

Sketch environment.  

 

Step 30 

We’re now going to create a 

cylinder using the circle sketch 

profile.  

1.  Select the entire circle profile. 

Hold the SHIFT key to add onto 

each selection.  
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Step 31 

1. Right click on the selected circle 

profile and select Extrude.  

 

Step 32 

1. In the command dialog, make 

sure that the Direction is set to 

Symmetric.  

2. Drag the arrow manipulator to a 

value of 19 mm.  

 

Step 33 

1. Change the Operation from Cut 

to New Body. Click OK to finish.  
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Step 34 

1. Turn off the Analysis in the 

browser. 

You should now see a cylinder body 

protruding from both sides of the 

knife body.  

 

Step 35 

We’re now going to create a 

counter-bore hole through the 

cylinder.  

1. Go to the CREATE drop-down 

menu and select the Hole 

command.  

 

Step 36 

1. Rotate around the model so you 

see the left side of the knife. 

2. Hover over the surface of the 

cylinder body until you see a center 

point appear.  
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Step 37 

1. Click on the surface with the 

center-point visible. This will snap 

the hole to the center-point.  

2. In the command dialog, change 

the hole-type to Counterbore.  

 

Step 38 

1. Drag the arrow that determines 

the depth of the hole to 28 mm. 

 

Step 39 

In the command dialog, set the 

diameter of the hole to 3 mm.  
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Step 40 

1. Now drag the arrow that 

determines the depth of the 

Counterbore to 15 mm.  

 

Step 41 

1. In the command dialog, change 

the Counterbore diameter to 6 mm.  

Click OK to finish.  

 

Step 42 

We’re now ready to split the body 

into 2 halves.  

1. Go to the MODIFY drop-down 

menu and select the Split Body 

command.  
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Step 43 

1. Click on the knife body as the 

Body to Split.  

2. Hover over the middle plane, 

click and hold the click until a 

selection dialog shows up. Choose 

the first Work plane as the Splitting 

Tool.  

 

Step 44 

You should see this as a result.  

Click OK to finish.  

 

Step 45 

Now that we split the knife body 

into two pieces, let’s split the 

cylinder body as well.  

1. Right click and select Repeat 

Split Body.  
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Step 46 

1. Click on the cylinder body as the 

Body to Split. 

2. Select the middle origin plane as 

the Splitting Tool. Click OK to finish.  

 

Step 47 

After the split body commands, 

you’ll see that you have 4 bodies in 

your Bodies folder in the browser. 

We’ll want to combine the left 

cylinder with the left knife body, 

and the right cylinder with the right 

knife body so that we are left with 

two bodies total.  

1. Hide the right side bodies so only 

the left side is visible.  

 

Step 48 

1. Go to the MODIFY drop-down 

menu and select the Combine tool.  

 

We’re going to use this tool to join 

the knife body with the cylinder 

body where we have our counter-

bore hole.  
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Step 49 

1. First, select the utility knife body 

as the Target body.  

 

Step 50 

1. Then select the cylinder body as 

the Tool body for the target body 

to combine with.  

2. Leave the Operation as Join and 

then click OK to finish.  

 

Step 51 

1. Hide the left side and make the 

right side bodies visible.  

2. Right click and select Repeat 

Combine to reuse the last used 

command, which was the Combine 

tool.  

 



CD7017-L Intro to Fusion 360 

39 
 

Step 52 

We’re going to repeat the last 

combine steps, but now for the 

right side bodies.  

1. Select the knife handle as the 

Target body, and then select the 

cylinder as the Tool body.  

2. Leave the Operation to Join and 

then click OK to finish.   

Step 53 

1. Let’s get rid of the 2 protruding 

cylinders by holding SHIFT and then 

selecting the 2 bodies.  

2. Press DELETE or BACKSPACE on 

your keyboard and the 2 bodies 

should just go away.  

 

Step 54 

Now you can see that the utility 

knife has a counter-bored hole that 

extends across the split bodies, just 

the way it would be manufactured.   
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Step 55 

Let’s make a change!  

1. Locate the sculpt operation in 

the timeline, right click and select 

Edit.  

This will allow you to get back into 

the sculpt environment and make 

change to the knife body itself.   

Step 56 

1. Select Left View on the 

ViewCube 

2. Click on the bottom surface 

3. Right click and select Edit Form 

 

Step 57 

1. Use the vertical arrow 

manipulator and drag the surface 

down to -5mm.  
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Step 58 

1. Now select the lower edge of the 

finger guard, and again, use the 

arrow manipulator and drag that 

edge down -5mm.  

Click OK to confirm.  

 

Step 59 

1. Now click FINISH FORM to finish 

the changes. 

2. Once clicked, the model will 

update automatically with all your 

downstream features still intact.  

 

Step 60 

1. Hide one of the bodies and 

notice that the webs and hole 

updated along with the change you 

made to the sculpted body.  
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And we’re done! Now that you 

know how the timeline works, you 

can select any of the commands 

used and make appropriate 

changes, such as web thickness, 

hole depth and diameter, shell 

thickness, as well as sketch 

dimensions.  
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Organize and assemble model components 

 

In this part of the class we perform some basic assembly operations to assemble the blade 

cradle to the knife body. We’ll also insert the blade into this design and assemble it to the blade 

cradle.   

Before moving on, make sure you have the 03_Utility_Knife_blade_assembly design open 

and in your design environment.  

If you’d like to watch the video to this tutorial, click here: Launch Video  

https://screencast.autodesk.com/Main/Details/953eba81-210f-4cc9-9cbc-25e5a4e5edda
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Step 1 

Let’s start by applying a joint 

between the blade cradle and the 

knife body.  

1. Go to the ASSEMBLE menu and 

select the Joint command.   

2. Select Pin-Slot as the joint type 

 

 

Step 2 

1. Select the middle joint position on 

the blade cradle pin. 

2. Select the middle joint position on 

the knife body slot, on the side for 

the blade to be fully retracted. 
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Step 3 

1.  Enter -1.5mm for the offset. 

 

 

 

Step 4 

1. Find the joint in the browser, use 

the attached tool to edit the joint 

limits.  

 

 

 

Step 5 

1. For Rotation, just click once to set 

min and max to 0°. 

2. For Slide, set min to 0 and max to 

28mm 

3. Slide it back and forth; click Revert 

on the snapshot panel, so as not to 

capture unwanted assembly 

positions. 

 

 



CD7017-L Intro to Fusion 360 

46 
 

Step 5 

Time to insert the blade and 

assemble it to the cradle. 

1. Go to the data panel, find the 

model:  03_blade, right click on it 

and pick Insert.  

When the blade inserts, click OK to 

accept the default insert location. 

 

 

Step 6 

1. From the assemble menu pick 

Joint. Use Rigid joint type. 
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3. For Component 1, select the hole 

edge on the blade, on the side 

nearest the cradle. 

4. For Component 2, select the root 

of the pin on the blade cradle. 

5. Drag the cradle back and forth! 

 

(images below) 
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Apply materials or appearances and render the model 

 

Overview 

Rendering is the process of generating an image by combining geometry, camera, texture, 

lighting and shading (also called materials) information using a computer program.  

Before an image can be rendered Appearance Materials are applied to the various parts of your 

design to visualize how your design would look in the real word.  Materials contain the visual 

properties of plastic, glass, metal, paint and wood (and pretty much anything else you can think 

of) to create photo-realistic images. 

 

Learning Objectives 

In this section you will learn how to: 

 Assign materials to your model 

 Edit and replace materials 

 Place decals on your model 

 Change the environment settings and background color 

 Change environment effects  

 Render an image using the Real Time Ray Tracer 

 Create images using the A360 Cloud Render feature  
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LAUNCH VIDEO for Applying and Editing Materials. 

 

Open Fusion360 file and go to Render Workspace: In this section you will open the design 

file for the Utility Knife and go the Render workspace so that you can apply materials. 

 

  

Step 1 – Open the Data Panel 
 

1. Open the Data Panel by clicking on the icon 
located at the top left of the menu bar.   
1. The Data Panel will slide open. 

 

 

 

https://www.youtube.com/watch?v=sVZD1U1Js2g&list=PLmA_xUT-8UlJpYbha60oAQMxFlBY371oZ&index=19
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Step 2 – Open the design 
 

1. At the top right of the Data Panel, select project 
from the project drop down list. 

2. Double-click on the design called 
04_RenderUtilityKnife to open the design in 
Fusion 360. 

3. When the design has opened in your modeling 
window, click on the icon to close the Data 
Panel. 

 
 

 

Step 3 – Go to Render Workspace 
 

1. Click on the Model icon in the left of the 
workspace to view other available workspaces. 

2. Select the Render Workspace 
 

You may notice that the environment changes slightly, 

this happens because the environments you use for 

modeling are different than the environments that 

have been created specifically for rendering. 

 

The Rendering workspace toolbar contains tools to 

Setup your render and to create a Render. 

 

In the Setup section you have access to 

 Appearance materials library to apply materials 

to your design 

 Environment settings to change the 

background and how lights are cast on your 

design 

 Decal tools for applying decals to your design 

In the Render section you have access to  

 Start/Stop a RRT Render 

 Save an image of your design 
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Apply Materials 

Now that the model is in the Rendering Workspace you can begin assigning appearance 

materials. There are two types of materials in Fusion360: 

Physical Materials dictate what the object is made of and is used in mass calculations.  In the 

absence of any appearance materials that have been applied to your design, you will see the 

default physical material.  The default physical material can be changed in your preferences. 

Appearance Materials dictate how the object will look when rendered. 

Note: in absence of Appearance material the Physical material will be shown in the render. 

 

Step 1 – Open Appearance tool 
 

1. In the Render Workspace click on Setup > 
Appearance. 

2. The Appearance dialog box opens 
 

Appearance dialog box has several sections to it: 
  
Apply To – Allows you switch between applying 
materials to bodies/components or to individual 
faces 
 
In This Design – Shows which materials have been 
assigned to parts of your design.  
 
Library – In this section you can switch between 
the new Fusion 360 Appearance Library and your 
personal Favorites Library.  It also contains the 
folders and sub-folders of materials broken down 
by common categories and example swatches of 
the materials. 
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Step 2 – Apply a Material directly to geometry 
 

1. In the Appearance dialog box scroll down 
to Plastic > Opaque > Plastic – Glossy 
(Yellow) 

2. Click and hold on the Plastic – Glossy 
(Yellow) swatch icon and drag it on to the 
main side body of the utility knife. 

a. The material on the part changes 
to Plastic – Glossy (Yellow) 

3. Repeat these steps so that Plastic – 
Glossy (Yellow) is assigned to both sides 
of the utility knife. 

 
In the Appearance dialog box you will notice that 
there is only one swatch for Plastic – Glossy 
(Yellow) even though that material has been 
assigned to two separate bodies.  If you assign the 
same material to several bodies in your design 
and do not edit them they will be automatically 
linked to the one material.  Editing the one 
material will affect all of the bodies that have that 
material assigned. 
 

 

Step 4 – Apply a material to a body in the browser 
 

1. In the browser locate the component 
called Grip 1:1 

2. Click the arrow to the left of Grip 1:1 to 
expand the contents of the component 

3. Click the arrow to the left of bodies to 
show the bodies that are assigned to that 
component. 

4. In the Appearance dialog box scroll down 
to Other > Rubber > Rubber – Soft  

5. Click and hold on the Rubber – Soft 
swatch icon and drag it on to Grip 1:1 > 
Bodies > Body 1 in the browser 

a. The material on the grip changes 
to Rubber - Soft 

 
TIP:  To assign a material to all of the bodies in a 
component, drag the material to the top-level 
component in the browser. 
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Step 5 – Apply additional materials 
 

1. Using the method of your choice apply the 
following materials to the parts listed 

 Plastic – Textured – Polka to Grip 2:1 

 Plastic – Translucent – Matte (Blue) 
to Blade Cradle:1 

 Metal - Stainless Steel – Satin to 
Blade:1 

 
NOTE: If you apply a material to a component and 
one or more of the bodies in the component 
already have a material applied you will be 
presented with an  option to remove appearances 
applied to the bodies. 
 
Keep - only the bodies you selected that didn’t 
already have a material applied will have the new 
material applied. 
 
Remove – all of the existing applied materials will 
be replaced with the new material you applied to 
the component 
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Editing Materials 

LAUNCH VIDEO for Applying and Editing Materials. 

Now that you have all the base materials applied to your design, you can customize the 

materials to look the way you want.  

There are two levels of editing for materials.  The basic or “lite” editor window enables you to 

quickly change: 

 Change the name of the material  
 Edit the color – either by dragging the 

color sliders or by entering an RGB value. 
 Change the scale of the texture or bump 

map that is part of the material (if 
appropriate) 

 Rotate the texture or bump map that part 
of the material (if appropriate) 

 Go to Advanced options 
 

 

 

The options in the advanced editor will differ depending on the material you are editing.  The 
example below is for textured plastic. 
 
 
 

https://www.youtube.com/watch?v=sVZD1U1Js2g&list=PLmA_xUT-8UlJpYbha60oAQMxFlBY371oZ&index=19
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Texture Mapping is a process in which a 2-D image called a texture map is wrapped around a 

3-D object.  In the physical world this is similar to applying wallpaper or veneer to a real object.  

The texture map can be used to change various properties of a material including the color of 

the material as is seen in the Wood materials, or the way highlights hit a surface as in the 

Rubber materials. 

Bump Mapping is a technique for giving a 3-D surface the appearance of deformities and depth 

(e.g.: wrinkles or bumps). Although a surface that has a bump map applied will appear to have 

real depth, the surface of the underlying object is not actually changed. The textured plastic 

materials all use bump maps. 

You can use the scale and rotate tools in the material editor to change size and orientation of 

the images that control the texture and bump results.   

Projection Mapping is a method for placing one texture across several separate faces in order 

to give the illusion that it is one solid or continuous object.  The texture map is applied to the 

projection type and “pushed through” the surfaces it projects on to.  Fusion 360 has 4 projection 

types to choose from: 

Planar The texture map is projected from a plane in a 
user defined direction 

 

 

 
Box 

 
The texture map is applied to a cube that 
surrounds the object and creates 6 planar 
projections 
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Sphere The texture map is applied to a sphere that 
surrounds the object.  This projection type will 
show a poll pinch point depending on the axis 
defined by the user. 

  

 
Cylindrical 

 
The texture map is applied to a cylinder that 
surrounds the object. 

 

 

 

To change the way the maps are projected on the surface right-click the body of the object in 

the browser and select Texture Map Controls from the drop down menu. 
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In this section you will swap out one material for another and change the parameters for several 

of the materials. 

Step 1 – Replace the Yellow Plastic Material 
 

1. In the Appearance dialog box locate Plastic 
– Glossy (Red) 

2. Drag the swatch from the library on to the 
swatch for Plastic – Glossy (Yellow) in the 
“In this design” section of the Appearance 
dialog box. 

 
TIP: All the bodies that had Plastic – Glossy 
(Yellow) applied now have Plastic – Glossy (Red) 
applied.  This is a quick method for swapping out 
materials in your design. 

 

Step 2 – Edit Plastic – Glossy (Red) 
 

1. Double click on the swatch for Plastic – 
Glossy (Red) in the “In this design” section 
of the Appearance dialog box to open the 
editor window for this material. 

2. At the top of the dialog box is the current 
name assigned to the material – double 
click in the name field and change the 
name to Plastic – Glossy (Orange) 

a. This will make it easier to find the 
material later if required 

3. In the middle of the dialog box there is 
section that allows you to enter RBG 
values for a specific color. 

4. Enter 240, 114, 14 to change the color 
of the plastic material to orange. 
a. You can also use the sliders to 

change the base color and the 
tone of the color 

5. Click the Done button. 
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You should now see the swatch for the edited 
material in the In This Design section of the 
Appearance dialog box.  If you hover over the 
swatch the modified name will appear. 
 
TIP:  If you want to see which materials have been 
applied to which bodies in your design you can 
right click on the swatch and pick Select Objects 
Applied To from the drop down list.  Doing so will 
highlight bodies in your design that have the 
selected material applied. 
 

Step 3 – Edit color and texture map for Plastic – 
Texture – Polka 
 

1. Change the name to Textured – Polka - 
Blue 

2. Using the method of your choice change 
the color of Plastic – Textured – Polka to 
blue. 

a. If you wish to match the blue of 
the blade cradle enter the RGB 
values of 48, 59, 150 

3. Change the scale of the texture map to 41.   
a. The slider can be used to 

interactive change the size of 
the texture map. 

4. Move the slider next to Rotate to 
interactively change the orientation of the 
texture map.  When you are satisfied with 
the orientation, click the Done button. 
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Step 4 – Change the texture projection method for 
Grip 2:1 
 
Texture Map Controls are used to change the type 
of projection method used on the object with a 
texture map.  Fusion 360 will automatically choose 
the best projection method when a material with a 
texture map is applied, if you are not satisfied with 
the look of the texture you can change the 
projection setting manually. 
 

1. Close the Appearance dialog box by 
clicking on the Close button. 

2. In the browser locate the component 
labeled Grip 2:1 and right click on it. 

3. Select Find in Window to bring the part in 
the center of the screen.  

4. Zoom in further so that you can clearly see 
the texture map on the surface. 

5. Right click on component Grip 2:1 and 
select Texture Map Controls from the 
dropdown menu to open the Texture Map 
Controls dialog box. 

6. In the dialog box, change the Projection 
Type to Box 

7. Click OK to accept the change. 
 
 
TIP:  Try selecting the other projection types to see 
the different results.  In some cases you may have 
to choose an axis for a projection direction. In 
those instances an axis widget will appear, simply 
click on the axis that best matches the direction 
you would like to project. 
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Step 5 – Edit and Duplicate a material 
 

1. In the browser locate the component 
labeled Blade:1 

2. Right-click on Blade:1 and select Isolate 
from the drop down menu list. 

a. All of the other components 
disappear leaving Blade:1 in the 
window. 

3. Right-click on Blade:1 and select Find In 
Window from the drop down menu list. 

4. Right-click on Blade:1 and select 
Appearance from the drop down menu list 
to open the Appearance dialog box. 

5. In the Appearance dialog box, double click 
on the Stainless Steele – Satin material in 
the In This Design section. 

6. Click on the button labeled Advanced… to 
open the advanced editor window. 

7. Change the name to Stainless Steel – 
Blade by click on the name field. 

8. The Roughness setting controls the 
amount of reflection in the material, 
change the setting to .50. 

9. Click on the Ok button to close the 
window. 

10. Right click on Stainless Steele – Blade and 
select Duplicate from the drop down 
menu. 

a. This creates a second material 
called Stainless Steele – Blade that 
has the exact same settings as the 
original. 

11. Double click on the copy Stainless Steele – 
Blade material to open the Material 
Editor. 

12. Change the name of the material to Blade 
Face 

13. Change the color to 75,75,75. 
14. In the Appearance dialog box change the 

Apply To: setting from 
Bodies/Components to Faces 

a. Now you can only apply materials 
to selected faces on a 
body/component 
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Apply a Decal 

LAUNCH VIDEO for Applying Decals, Change Environment and Rendering 

In this section you will apply an image of the Autodesk logo to the body of the utility knife using 

the decal tool. 

15. Drag the Blade Face material to the side 
face of Blade:1 

16. Repeat this step on the other side of 
Blade:1 so that both side faces have Blade 
Face applied. 

17. Close the Appearance dialog box. 
18. Right-click on Blade:1 in the browser and 

select Unisolate from the drop down 
menu list to show the rest of the design. 

 
NOTE:  If you apply a material a body that already 
has a material(s) applied to one or more of it’s 
faces you will be presented with a choice to keep 
or remove appearances applied to the faces: 
 
Keep - all of the existing materials on the face will 
not be replaced with the new material you applied 
to the body. 
 
Remove - all of the materials on the faces will be 
replaced with the new material you applied to the 
body.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.youtube.com/watch?v=f90hKByKv_0&list=PLmA_xUT-8UlJpYbha60oAQMxFlBY371oZ&index=20
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Step 1 – Download the image file 
 

1. In the Data Panel find the item 
named Autodesk Logo.jpg and 
double-click on the information 
icon to launch A360. 

2. Click on the blue Download button 
on the upper right side of the 
window 

3. Place the file in a location where 
you can easily find it.  Your 
desktop for example. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Step 2 – Apply the decal 
 

1. In the Render toolbar select Setup 
– Decal 

a. The Decal dialog box 
opens. 

2. Click on the body of the utility 
knife to highlight it.  This is the 
surface you will apply the decal to. 

3. In the Decal dialog box click on 
Select Image 

4. From the file menu go to the 
location where you saved 
Autodesk Logo.jpg, select the file 
and click Open. 

a. The image appears on the 
face you selected with a 
move widget similar to the 
one you use for moving 
objects. 

b. The Decal dialog box also 
expands to show 
additional inputs for 
distance, angle and scale. 
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Step 3 – Adjust the decal 
 

1. Adjust your view of the knife so 
that you can see the side of the 
handle 

2. Use the rotate handle on the 
widget to rotate the decal so that 
it is lined up with the handle. 

3. Use the XY Plane scale handle to 
scale the decal down. 

a.  You can also input 0.85 in 
the Scale Plane XY field in 
the Decal dialog box. 

4. Click on the OK button to accept 
the decal location. 
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Environment Settings 

The Environment Setting controls the lighting, background color, and visual effects in the 

rendering workspace. In Fusion 360 an environment dome with an environment image map 

(called a high dynamic range image or HDRI) attached to it constantly surrounds the 3-D model.   

These images reflect in the surface of your model and are used to simulate lighting.   

 

In this section we will choose the environment, change the background color and turn on 

effects. 

 

LAUNCH VIDEO for Applying Decals, Change Environment and Rendering 

 

https://www.youtube.com/watch?v=f90hKByKv_0&list=PLmA_xUT-8UlJpYbha60oAQMxFlBY371oZ&index=20
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Step 1 – Change the Environment settings 
 
In the Environment section you can pick the type of 
environment map you want to use.  There are 8 maps to 
choose from.  6 of them are designed to simulate a photo 
studio set up.  The remaining 2 (Plaza and Snowfield) are 
HDR photos of outdoor environments.   

4. In the Render workspace click on Setup > 
Environment.   

a. There are 3 main sections to this tool: 
i. Environment 

ii. Background Color 
iii. Effects 

5. Select several styles from the dropdown list.  
Notice that the reflections change as well as the 
pre-assigned background color for each style. 

6. From the Style dropdown list select Sharp 
Highlights. 

7. Use the slider next to Exposure to change the 
light level in the scene.  Pick an exposure setting 
you like.  

a. If you want to go back to the default 
setting type 0.0 in the field next to the 
slider 

8. Use the slider next to Rotation to rotate the 
environment image around the dome. 

b. As you move the slider you will see 
reflected highlights change on the design. 

9. Rotate the environment until you see a highlight 
across the right side of the knife. 

c. You can also type 57 in the field next to 
Rotation. 

 

 

Step 3 – Choose a background color 
 
By default the background color is defined by the 
environment style you choose.  You have the option to 
change the background color to whichever color you 
want. 
 

1. In the Background Color section click on Custom 
Color. 

a. The background changes to white. 
2. Click on the white swatch next to Custom Color to 

open the color chooser dialog box. 
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a. This dialog box is similar to the color 
chooser in the material editor.  You can 
pick colors by using the sliders or enter an 
RGB value. 

3. Keep the background color as white. 
 

Step 3 – Change the Ground Effects 
 
You have the option to have your design cast a shadow or 
to reflect your model on the ground plane of the 
environment.   
 

1. Click on the button next to Ground Shadow. 
a. Now you can see a shadow being cast on 

the ground plane. 
2. In the Environment section change the rotation 

value. 
a. Notice that the shadow location is 

changing based on the location of the 
light sources in the chosen environment 
style. 

3. Click on the button next to Ground Shadow to 
turn it off.   

4. Click on the button next to Ground Reflection. 
a. Now you can see a reflection of your 

design on the ground plane. 
 
TIP: Correct shadow computation takes a lot of time to 
render.  If you want to speed up the render time avoid 
using ground shadows. 
 
NOTE: In the Display Settings at the bottom of your screen 
there are Effects setting that can affect your rendering. 
In particular: 
 
Ground Plane – turning off the ground plane will turn off 
ground shadows and ground reflections. 
 
Ground Shadows and Ground Reflections – are the same 
commands that are in the Environment > Effects section. 
 
All the other commands in Display Settings only affect the 
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GPU rendering in your modeling window (See Rendering 
section for definition of GPU rendering) and will not affect 
the results of Rapid Ray Tracer or Cloud renderings. 
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Rendering 

Now that the design has materials applied and the environment is set correctly it is time to 

create a rendered image.  There are 2 types of rendering methods in Fusion 360: 

Graphics Processing Unit rendering (GPU) is the rendering you see in the modeling window 

and uses your computer’s graphics card to show the materials and lighting that have been 

assigned to your model and is similar to the technology used in computer gaming. This method 

uses the least amount of resources on your computer to create the images.  It shows the 

materials assigned to your design in real time but is not photo-realistic. The analysis tools in the 

Model >Inspect dropdown (zebra, draft and curvature map) also use GPU rendering to show 

the results. 

Rapid Ray Tracer (RRT) in the Rendering Workspace can be used to create photo realistic 

images from your Fusion 360 models.  Ray Tracing attempts to simulate the natural flow of light 

in your scene using a technique called Global Illumination (GI) which takes in to account not 

only the direct light that comes from a light source but also indirect light that reflects off of other 

surfaces in your scene.   The Real Time Ray Tracer requires you to let the rendering engine 

complete multiple iterations in order to get a high quality image – during this time you cannot 

interact with the workspace or the rendering will restart. 

Under Render – Ray Tracing there are 3 quality settings Quick, Normal and Advanced 

 

Quick:  At this setting the materials in the scene are 
approximated as either completely polished or completely 
diffuse and completely ignores indirect light.  In the rendered 
image you will see reflections but you don’t get any indirect 
light. This can be considered as a type of enhanced GPU mode. 
 
Normal: At this setting the materials are approximated as 
either completely polished or completely diffuse and the 
indirect light in the scene is also approximated.  This setting 
allows you to get to a noise free image quickly and get a good 
view of the total light in the scene. 

 
Advanced: This setting does a full physically based rendering 
with full and accurate simulation of direct and indirect light and 
a full simulation of all material properties. In this mode the 
image will start off noisy before the image has converged and 
can take a long time to generate a photo realistic image. 
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LAUNCH VIDEO for Applying Decals, Change Environment and Rendering 

Explore Fusion 360 rendering: In this section you will change the settings of the Render > 

Ray Tracing quality settings to observe the differences, and use Render > Capture Image to 

save a PNG file to your desktop. 

 

The Rapid Ray Tracer is a real-time ray tracer, meaning that as soon as you click on the 

Enable Ray Tracing icon your computer will start rendering the image immediately.  The image 

will start off noisy and will start clearing up.  If you change the orientation of the model or 

change materials and environment the Rapid Ray Tracer will restart the rendering process. 

 The length of time needed to create the image is dependent on the Quality setting and the 

number iterations (or passes) that are needed to create the image.   

Step 1 – Start the Rapid Ray Tracer 
 

1. From the Render toolbar select Render > 
Enable Ray Tracing. 

a. The Rapid Ray Tracer starts and the 
Ray Tracer dialog box opens. 

 
 
 

 
(Sample screenshot) 

Step 2 – Change the Quality setting 
 

1. Set the Quality setting to Quick 
a. The image clears up rapidly but the 

image is not high quality 
2. Change the Quality to Normal 

a. The image clears quickly but you will 
notice that the edges of the model look 
jagged or pixelated and will slowly 
smooth out as the number of iterations 
rise. 

3. Change the Quality to Advanced. 
a. The image is very noisy to start and will 

continue to clear up over time. 
 

 

 
 

https://www.youtube.com/watch?v=f90hKByKv_0&list=PLmA_xUT-8UlJpYbha60oAQMxFlBY371oZ&index=20
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Because materials and lighting are approximated, Quick mode creates an image in a short 

amount of time. 

For the Normal mode you usually only have to run around 10 iterations to get nice anti-aliased 

edges and get the noise in shadows to disappear. This will vary somewhat depending on 

materials and lighting but in general you would need quite few iterations. Once the image is free 

of noisy shadows or aliasing the image will not get better by letting it render longer. 

For the Advanced mode the amount of time needed to create a good image will vary a lot 

more. Some scenes and some materials will take a lot longer to get noise free. Frosted Glass is 

one such material for instance. In general you usually need a couple of hundred iterations for a 

relatively complex scene to get totally noise free. The length of time needed is totally scene and 

material dependent so really complex scenes may need up to 500 iterations or more. In the 

Advanced mode you can generally see if that if an image looks noisy, it will benefit from longer 

rendering time. 

 

 
Advanced Mode – 50 iterations 

 

 
Advanced Mode – 500 iterations 

 

 
Advanced Mode – 5000 iterations 

 
For the image above a range of 1500 – 2000 iterations should be sufficient to create a high-

quality image. 
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Step 3 – Pause and Disable the Ray Tracer 
 

1. In the Ray Tracer dialog box – click on the 
Pause button 

a. The render pauses and both the 
Elapsed Time and Iterations stop 
counting. 

2. Click the Continue button to let the Ray Tracer 
continue rendering where it left off. 

3. Click on the Disable button to turn off the Ray 
Tracer. 

 
NOTE: You can also click on the Disable Ray Tracing 
icon in the tool bar to disable the render. 

 

 

Step 4 – Create a Normal quality Ray Trace and Capture 
an image. 
 

1. From the Render toolbar select Render > 
Enable Ray Tracing. 

2. Change the Quality setting to Normal 
a. Let the Ray Tracer run for about 120 

seconds or until you are satisfied with 
the look of the rendering. 

3. Hit the Pause button in the Ray Tracing dialog 
box. 

4. From the Render toolbar select Render > 
Capture An Image 

a. The Image Options dialog box opens 
b. In the Image Options you can change 

the size of the image you want to save 
and have an option to create a 
transparent background. 

5. Leave the Image Options at the default and 
click on OK. 

6. In the Save As box enter a name for the file and 
set a location to save the image. 

7. Click on the Save button. 
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A360 Cloud Render is also a ray trace renderer that uses the cloud resources in A360 to do 

the image calculation rather than your desktop resources so you can continue to work while the 

images are being created.  The cloud renderer automatically creates small sized rendered 

images based on the Top, Front, Right and Home named views in your browser every time you 

save a new version or an auto save is done. 

If you want to create an A360 Cloud Render of a specific view you need to create a new named 

view. 

In this section you will locate the cloud rendered versions of the knife design and create new 

named view for a custom rendering. 

Step 1 – Open data details in A360 
 

1. Click on the icon in the upper left corner of the 
screen to open the Data Panel 

2. Find the Rendering: Utility Knife file in the list 
and click on the information icon in the bottom 
right. 

a. A window opens below the file to show 
additional information. 

3. Click on Open details in A360 
a. Your default browser will launch and 

take you the item details page of the 
A360 project 

b. By default a lite 3D version of the 
model is shown 

4. Click on the picture icon on the left hand side of 
the window to show the renderings 

a. You are now able to see the renderings 
that were automatically generated 
using the A360 cloud render.  By 
default you can see the last version you 
saved.  Thumbnails of the rendered 
named views are visible on the left side 
of the window.  Clicking on any of them 
will show you larger version in the main 
window. 

5. Hover your cursor on any of the thumbnails to 
show additional information about the image. 

6. Close the window by clicking the X in the right 
corner. 

7. Close your browser window. 
8. Return to Fusion360. 

9. Close the Data Panel 
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Step 2 – Create new Named View 
 

1. In the browser click on the small arrow next to 
Named Views to expand the list of current 
named views. 

a. Named Views are basically preset 
camera shots.  By default there are 
Top, Front, Side and Home 

2. Click on any of the named views to see that 
preset. 

3. Arrange your design in the main window in a 
way that you would like your A360 Cloud 
Rendered image to look. 

4. Right click on the Named View heading in the 
browser. 

5. Click on New Named View in the drop down 
menu. 

a. A new named view is created based on 
the current window configuration with 
the label NamedView 

6. Double click on NamedView to highlight it and 
type Render to change the label and hit enter 

a. The label has changed to Render 
7. Click on the Save icon to save a new version of 

the design. 
 

TIP: Name views can also be deleted or updated to a 
new camera position by right clicking on the named 
view and selecting Delete or Update Named View. 
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Thank you from Autodesk and the Fusion 360 team! 

Step 3 – Download the image from A360 
 

1. Following the previous steps navigate back to 
the thumbnails of the A360 Cloud Render. 

a. A new thumbnail has been added 
called Render. 

2. Select any of the rendered thumbnails to see 
the larger image in the middle of the screen 

3. Click on the Actions button at the bottom of 
the window. 

4. Select Download Image from the menu 
 
NOTE:  A360 Cloud Rendering service offers you the 
opportunity to re-render any of your current thumbnail 
images with new render settings.  Depending on the 
type of entitlement you have some of these options will 
cost cloud credits. 

 


